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Introduksjon 
 
Velkommen til BERNINA® Broderi Software, det ledende 
broderi/design-programmet for hjemmebrukere. Detta er et 
MS Windows®-basert produkt der man benytter seg av det 
konventionelle PC-språket som mange allerede kjenner til. 
BERNINA Broderi Software er unikt fordi du enkelt kan skifte 
mellom CorelDRAW® Essentials X6 via Corel Corporation, det 
mest populæra vektor-baserte  tegneprogrammet for 
hjemmebrukere. Denne kombinasjonen tilbyr en mer effektiv & 
brukervennlig mulighet til å lage broderidesigns ved å 
kombinere den broderi-tekniske kapasiteten fra BERNINA 
Broderi Software med den grafiske kapasiteten fra CorelDRAW®. Det muliggjør også at man kan 
lage ikke bare broderi, men også design bestående av mange ulike  teknikker.   
 

 
Noter CorelDRAW®Essentials og dets søsterprodukt, Corel PHOTO-PAINT® Essentials X6 kan også 
brukes separat. En komplett beskrivning av verktøy og egenskaper finner du i User Guiden via 
Windows Start > Programs gruppen. Alternativt, bruk onscreen help via Graphics  og Help 
menyen 
 
Førstegangs brukere 
Om du bruker BERNINA Broderi Software for første gang, vil du bli fornøyd med dets fleksible 
stingsettingsmuligheter, enkelheten i hvordan du kan skape og redigere design og hvor enkelt 
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det er å legge til tekst.  Allikevel, før du begynner å bruke produktet, les vennligst Kom igang på 
side 6.  

 
Update brukere 
BERNINA Broderi Software er en forbedret versjon av våre tidligere produkter. Den har mange 
nye og utvidede egenskaper. Vennligst les i Release Notes tilgjengelig fra Help menyen for å 
raskt gjøre deg bekjent med hva disse forbedringene omfatter!  

  

Security device / dongle 
 
BERNINA Broderi Software beskyttes av en sikkerhetslås / dongle. Om denne  ikke er tilkoblet 
når du forsøker å  starte programmet, vil det ikke fungere. Hver dongle har 
et unikt  serienummer og identitetskode, slik at ditt system kan 
igjenkjennes.  
Dongelen er den mest verdifulle delen i ditt system og må håndteres 
forsiktig. Oppbevar den alltid på et sikkert sted når den ikke brukes. 
Dongelen omfattes av garanti mot brister i materiale og produksjon, ved 
normal bruk og korrekt installasjon, for en tid på 12 måneder f.o.m 
kjøpsdato. Dog, kommer den bort eller blir stjålet, må du kjøpe et helt nytt 
BERNINA Broderi Software for å kunne arbeide videre.På grunn av dette, er 
det en god idé å forsikre din dongle.  
 

Installere software-programmet 
 
Installasjonsprosessen lar deg velge:   

►      Hvor software-programmet og alle designs installeres på din PC/nettverk. 
►        Hvilke deler som blir installert – f.eks flere språk, BERNINA Portfeolio e t c. 
►        Hvilke dokumentasjons-filer som installeres. 
          Om du oppdaterer din software, så behøver du IKKE å vinstallere den tidligere versjonen. La 
          Installasjonsprosessen gjøre dette for deg.   
 
 

Slik installerer du software-programmet 
►      Lukk alle andre programmer på din PC. 
►        Koble også fra din brannmur og antivirus program for å forsikre deg om at softwaren og drivere                            
          Installeres korrekt.  
►        Legg i installations-cd’n  i cd-rommet på maskinen og følg anvisningene. 
►        Du vil bli guidet til når du skal sette i dongelet. Om du har et oppdaterings-kit, 
          Blir du også bedt  om å sette i din gamle dongle.   
 

           
 
►        Hvis din PC allerede inneholder en eller flere eldre versjoner av BERNINA Broderi Software: 
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          ►       Så blir du oppfordret til å  velge en versjon å sammenføye den nye versjonen med.  
          ►       Den eldre versjonen sammenføyes med den nye når maskinen startes på nytt.  
          CorelDRAW® Essentials X6 installeres som en del i den normale installasjonen. 
 

►        Du får valget å starte om pc’n med den nye installasjonen. Snarveis-ikoner blir plassert  
          på MS Windows® skrivbordet og på følgende plass; Start > Programs gruppen. 
 

►        Åpne BERNINA Broderi Software. 
          Hvis du har gjort noen endringer i din gamle BERNINA Quilters stoff-bibliotek, så vil de nå  
          sammenføyes med den siste installasjonen. Installasjonen sammenføyer også brukerdefinerte 
          mønster eller motiv. 
 

Hjelp & support 
 
BERNINA Broderi Software tilbyr flere veger til hjelpinformasjon om software-programmet og 
hvordan man bruker det. Det finnes også linker til kilder med ferdige broderi-motiver. 
 
   adgang til 

onscreen manualer 
 
 
 
 
adgang til BERNINA og 
OESD broderi/design studios 
 
 
 
Bestill og installer oppgraderinger 

 
    

Onscreen Manual 
Avhengig av ditt produkts nivå, vil disse manualene inkludere deler av, eller følgende: 
 
Release notes 
Denne oversikten installeres automatisk , og beskriver de nye og forbedrede egenskapene i den 
nye versjonen av programmet, samt linker til relevante deler i Reference Manual. 
 
Reference Manual 
I manualen finner du detaljerte beskrivelser på alle prosedyrer og funksjoner i BERNINA Broderi 
Software ’Embroidery Canvas’. Programavsnittet BERNINA Cross Stitch og BERNINA Quilter 
finnes dokumentert i separate tilleggsmanualer. 
 

 
Noter En komplett beskrivelse av CorelDRAW®-verktøyet som finnes i ’Artwork Canvas’, finner 
du i den elektroniske User Guiden/brukermanualen som er tilgjengelig via ; Windows Start > 
Programs gruppen. Alternativt, bruk onscreen help som du finner via Graphics-> Help menyen. 
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Onscreen help/hjelp 
Onscreen help gir deg raskt tilgang til allmenn informasjon om BERNINA Broderi Software-
funksjoner og steg-for-steg instruksjoner. Trykker du <F1> så får du nærmere beskrivelse. 
 
 
 
 
 
 
 
 
 
 
Ytterligere hjelp 
Med din BERNINA Broderi Softwareinstallasjon, får du også ytterligere hjelp om de 
underordnede programmene: 

 
►      BERNINA Cross Stitch: Denne beskriver hvordan du bruker funksjonene i det spesielle 
          BERNINACross Stitch-programmet.  
►        BERNINA Quilter: Denne beskriver hvordan du bruker funksjonene i det spesielle BERNINA 
          Quilter-programmet. 

 

Online Broderier 
Det finnes mange måter å finne ferdige broderimotiv/designs som du kan kjøpe og bruke som 
du ønsker. Ditt BERNINA Broderi  Software henviser deg til to gode kilder – BERNINA og OESD 
embroidery design studios. 
 

 

Software oppgraderinger 
 
Du kan oppgradere din BERNINA Broderi Software direkte via Help-menyen som vist tidligere. 
Når du refererer til ditt system ved kontakten med BERNINA forhandleren, så må du oppgi ditt 
Dongle Nummer. Du må også muligens oppgi Serial Nummer og Identity Code. Denne 
informasjonen finner du direkte på dongelen. 
Informasjonen kan også finnes under Security Device 
Options dialogruten som du finner via Settings-menyen. 
Online oppgraderinger kan gjøres via Purchase Upgrades on 
the Internet kommandoen under Help-menyen. Denne 
hjemmesiden tilbyr deg ulike oppgraderinger, avhengig av 
ditt nåværende nivå på din dongle. Hvis din dongle har 
BERNINA EditorPlus-nivå, så vil hjemmesiden tilby en 
oppgradering til BERNINA DesignerPlus. 

 
 

  
Advarsel Hvis nettleserens sikkerhetsnivå er satt for høyt, kan det hende du ikke kan laste ned 
oppdateringer. Opplever du dette problemet, prøv å senke sikkerhetsnivået til medium.  
 



BERNINA® Embroidery Software 7      
Quick Start Guide 

 

6 
 

Kom igang 
 
Hvis du nettop har startet med BERNINA Broderi Software 
eller maskinbroderi, er du kanskje usikker og tenker  
”hvordan begynner jeg?”.En ting er sikkert, og det er at du 
kommer til å bruke mange timer, både lykkelige og iblandt 
frustrerende, når du holder på å lære deg hvordan du får ut 
det største potensialet i din BERNINA maskin og dette 
softwareprogrammet. Disse to arbeder hånd-i-hånd og det 
trengs trening og tålmodighet for å beherske både å lage et 
design og gjennomføre et perfekt broderi.  
 
Resultatet, dog, kommer til å snakke for seg selv, og gjør 
tiden du bruker enda mer verdifull. Med hvert prosjekt du 
ferdigstiller, vil din erfarin og sikkerthet økes før neste 
utfordring.  

 

Begynn i riktig rekkefølge 
 
Du behøver ingen tidligere erfaring for å begynne med BERNINA Broderi Software. Du kan  
enkelt åpne et design og sende det til maskinen for å ’brodere ut’. Og dette er den beste  
måten å begynne på. Når du har blitt litt mer erfaren, vil du kunne se på forskjellige designs og 

se hvilke som er av god kvalitet og hvilke som vil kunne lage problemer for deg.  

 
Eksempelmotiv og artwork 
BERNINA Broderi Software inneholder hundrevis 
klare-til-å-sy motiv, inklusive mangevakre 
ornamenter, eksempelmotiver og bilder. Designfiler 
(ART filer) og bilder (BMP, JPG, og WMF filer)  
kan hentes i My Designs > Embroidery Software 7 
mappen. Det viktigste du bør gjøre som ny  
bruker, er å bruke litt tid og utforske alle disse 
motivene og hvordan du finner dem. 
 

 
Noter Med BERNINA Broderi Software medfølger også 
egne BERNINA Portefolio motivhentere for enkelt å 
kunne se på og håndtere dine broderimotiver. 
Alternativt, utforsk design-mappar ved hjelp av MS 
Windows®Explorer. 
 

Andre kilder 
Det finnes mange andre kilder med ferdige 
broderimotiver som du kan kjøpe og bruke som du vil. 
Din BERNINA Broderi Software henviser til to pålitelige 
kilder – BERNINA og OESD embroidery design studios.  
 

 

Link til BERNINA &  
OESD embroidery  
design studios 
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Clipart 
Med CorelDRAW®Essentials X6 følger en  
gruppe med clipart som du finner via Program- 
gruppen. Forsikre deg om at du gjør deg bekjent  
med alle  Clipart eksemplene. Mange kan  
redigeres og brukes til broderi-designs, enten som 
utgangspunkt eller for direkt stingsetting. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Det kan være enklere å jobbe om du helt enkelt lager en kopi av hela CorelDraw®Essentials X6 
Clipart-mappen og så lagrer den i My Designs > Embroidery Software 7-mappen for å enklere 
finne frem. 
 

  
Advarsel De inkluderte artwork-bildene (clipart) og broderi-motivene får kun brukes til personlig 
bruk – og skal ikke brukes til kommersielt salg.  
 

Regler for et fint broderi 
Kontroller følgende punkter når du gransker et broderi, både dine egne og andres: 

          ►       At stingene ligger korrekt, jevnt og rett. 
          ►       At designet ser bra ut – former, farger, balanse. 
          ►       At formene er fylt med korrekte fyllsting og kontursømmer. 
          ►       At stingvinkelen ligger i beste vinkel i forhold til formen. 
          ►       At stingene er sydd uten uønskede mellomrom. 
          ►       At detaljer er tydlige. 
          ►       At tekst er tydelig og enkel å lese. 
 

          Et utsydd broderi bør også karakteriseres av følgende:  
 

          ►       At designet syes effektivt på maskinen. 
          ►       At stoffet ikke bukler seg rundt de sydde områdene. 
          ►       At designet er fritt for løse tråder. 
 

           

Her finner du CorelDRAW® 
clipart-mapper. 



BERNINA® Embroidery Software 7      
Quick Start Guide 

 

8 
 

          God broderikvalitet begynner  med et godt design. Videre behøver du en kvalitetsmaskin for å          
          sy ut  broderiet. Men selv ikke det er tilrekkelig om du ikke bruker rett stoff , tråd, stabelisering,  
          trådspenning etc. Les mer i din symaskinsmanual for råd og ta til deg så mange gode råd som 
          mulig fra andre som broderer.  
 

Sy et allerede ferdig design 
 
For mange som broderer, holder det lenge å ta et allerede ferdig design og brodere ut. Dette er 
sikkert det de flesta begynner med. Når du har funnet et design du liker, vil du gjerne 
forhåndsvise og se hvordan det kommer til å se ut ferdig. Til dette kreves et antall trinn, vi 
beskriver de viktigste trinnene her.   

 
 

Å sy ut et design 
►       Åpne designet i BERNINA Broderi Software. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
           ►       Velg ønsket innstilling  til forhåndsvisning. 
 
 
 

 
 
 
 
 

           ►       Kontroller stoffkvaliteten og endra evt innstillninger ved behov via Design > Fabric Settings            
                   Menyen. 

 
 
 
 
 
 

 

Aktuelt/valgt stoff 

Filtype Stingteller 

Send designet til 
maskinen 
direkte eller via USB 
 

Åpne designet 
 

Forhandsvis designet før 
utbrodering 
 

 

Juster innstillingene 
til design view 

 

Juster zoom-faktoren 
=vist størrelse på 

motivet 
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           ►       Trykk Shift+R for å kunne forhandsvise hvordan motivet vil sys (som en film). 
        
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

           ►       Send broderimotivet/designet til maskinen direkte via ledning eller via f.eks USB-stick. 
                   Les i din BERNINA maskinmanual hvordan du gjør videre for å brodere. 

 

Redigere et design 
 
Når du har vent deg til de ulike stegene ved å brodere ut et design – enden clipart eller noe du 
har kjøpt, vil du nok snart ønske å gjøre endringer som å endre størrelse, bytte trådfarger og 
stoffkvalitet. Dette er relativt enkle endringer. 

 
Å endra et helt design 
►       Åpne designet du ønsker å jobbe 
med og klikk på det for å velge det 
(Select). 

 
 

►       Kontrollere størrelse og endra evt. 
Eks; om du ska brodere et design til 
venstre bryst, bør størrelsen være max  
ca 108mm i kvadrat 
 
 
 
 
 

           ►       Endre trådfarger etter eget ønske. 
 
 
 

 
 
 
 
 
 

Start visningen 

Juster bildeskjermsvalg 

Stitch range viser hvor i  
motivet du befinner deg 

Velg og legg til valgt farge Veksle mellom ulike  
fargekombinasjoner 

Bytt tråder 

Kontroller dimensioner og 
endre størrelse 
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           ►       Kontroller stoffkvalitet og endre evt via Design > Fabric Settings menyen. 
 
 
 
 
 
 
           ►       Vis rammen. Hvis du høyreklikker på symbolet så kan du også bytte/velge størrelse på      
                   rammen 
 
           ►       Velg Design > Background menyen for å visualisere designet direkte på et klesplagg eller  
                    liknende.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
           ►       Send designet til maskinen direkte eller via et USB-stick. 
 

Lage et enkelt tekst-design 
 
Nrr du ha vent deg til de ulike trinnene for å brodere ut et design og endre størrelse, bytte 
farger og velge stoffkvaliteter, vil du definitivt komme til å ville lage dine egne tekst-design. Det 
kan ta litt tid å lære seg å få til kvaliteten på utbroderingen, men det er ikke vanskeligere  enn å 
skrive på maskin når du lager et attraktivt design i BERNINA Broderi Software. 

 
 

 Å lage et enkelt tekst-design 
►       Åpne et design. Ofte  
         Øsnker du å legge entekst til et    
         Allerede ferdig design.  
►       Legg til broderi-tekst til designet 
         direkte på i bildeskjermen. 
 
 
 
 
 

Vis ramme 

Legg til broderitekst 
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►       Høyreklikk på tekstverktøyet hvis du ønsker å endre på aktuelle instillinger. Det er enkelt 
         å justere basislinjer, teksttformat, avstand og farger. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
►       Broder ut ditt tekst-design. Studer stingkvaliteten. Vær oppmerksom på at alfabetet syes  
         ut best i visse størrelser. 
 

Lage et monogram-broderi 
 
BERNINA Broderi Software gjør det å lage 
et monogram-design veldig enkelt med 
’alt-i-et’ verktøyet Monogramming tool 
som du finner under Lettering tool. Du kan 
velge tekstformat, ornament og opp til fire 
konsentriske border til ditt monogram. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Justere basislinjen, 
tekstformat e t c 

Border syes i rekkefølgen 
– 1, 2, 3 e t c 

Ornament sys 
deretter 

Velg de ulike flikene i 
Monogramming-boksen for 
å endre instillninger for 
tekst, ornament og border. 

Tekst broderes til sist 
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Lage broderi automatisk 
 
Hvis du har gradert opp din kunnskap så langt i utforskingen av din BERNINA maskin og 
BERNINA broderi Software, klarer du deg helt klart godt. Du kan allerede oppnå mye uten 
egentlig å måtte lage dine egne design eller noe betydelig stingsettingsarbeid. Men nå når du er 
kommet så langt, er det sannsynligvis akkurat det du ønsker å gjøre!  
En av de raskeste måtene å komme i gang er å bruke de automatiske teknikker som BERNINA 
Broderi Software tilbyr. Mens det også finnes begrensninger for hva som kan oppnås på denne 
måten, kan du relativt raskt produserer ferdige broderi av designideer og kanskje  er de helt 
tilstrekkelig for ditt formål. I det minste for nå! 

Konvertere Vector artwork 
Spesielle verktøy i BERNINA Broderi Software konverterer automatisk et vector-objekt og tekst 
til et broderi eller et tekst-broderi. Disse kan siden redigeres etter eget ønske.  
 
 
 
 
 
 
 
 
 
 
 

 

 
Tips En god måte å begynne på, er å bruke noen av alle de clipart –eksemplene som følger med 
Corel DRAW®. Mange av disse kan tilpasses til å brukes til broderi. 
 

Konvertere Bitmap artwork 
Magic Wand-verktøyet gjør det mujlig å automatisk stingsette deler av et bilde eller utvalgte 
former.  Med den samme teknik enkan du bruke Auto Digitizer som omkonverterer et helt 
bilde til broderi og avgjør hvilke stingtyper som er best å bruke. 
 
 
 
 
 
 
 
 
 
 
 
 

 

Bruk denne funksjonen for 
å konvertere mellom 
artwork og broderi. 

Bruk Magic Wand og 
Auto Digitizer for å 
kjenne igjen former i 
artwork og konvertere 
til broderi. 
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Tips Husk å studere alle de eksemplene som følger med ved installasjonen av BERNINA Broderi 
Software. Prøv å brodere ut i etterkant, så du enklere kan forstå de ulike teknikkene og 
eventuelle begrensninger.  
 

Neste steg 
 
Om du har nådd helt hit, behersker du allerede 90% av teknikene  de flesta som broderer 
behøver. Dog kommer her neste trinn, om du vil ta tak i de dypeste kunnskapene innen 
manuell stingsettning. Men du behøver ikke dypdykke med en gang. Begynn med noen enkle 
projekt og jobb deg oppover til mer kompliserte designs, med mer kompliserte stingeffekter. 
Les gjerne i Reference Manual eller via de mange online-kildene. 
 
 
 
 
 
 
 
 
 
 
 

 
Spesielle broderi-egenskaper 
Når du behersker manuell stingsettning, så er du kapabel til å bruke det kompletta utvalget av 
stingtyper og effekter BERNINA Broderi Software tilbyr, til din fordel. Mange av dem kjenner du 
til, når du nå allerede har redigert eksisterende designs med forskjellig resultat.  
 
 
 

 
Noen av alle de teknikkene  som finnes i BERNINA Broderi Software: 
►       Frihånds-broderi 
►       Mønsterstempel, konturer og fyllsting 
►      ’ Handbroderte’  border og fyllsting 
►       Applikasjonssøm 
►       Korssting 
►       Knapphull 
►       Multi-dekorasjon 
►       Quilting 
►       opphøyet broderi 
 
Les mer i Reference Manual eller i de mange online 
kildene. 
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Ha det morsomt med broderi! 
 
Du kommer til å lage mange fine arbeider med din BERNINA maskin og BERNINA Broderi 
Software. Med denne utrustningen har du alt du behøver for å lage proffessjonelle broderier i 
toppkvalitet. Det eneste som mangler er kapasitet til å masseprodusere! 
Husk å bruk alle de medfølgende broderidesgins og clipart. Er du usikker, gå tilbake til de 
grundleggende prinsippene. Og når du vil utvide ditt reportoar, studer alle øvningseksempler 
nøye for å lære deg hvordan man jobber. 
Vi ønskar deg alt det beste. Og at du har det gøy! 
 
 

BERNINA Broderi Software Quick Reference  
 
I BERNINA Broderi Software er CorelDRAW® Essentials X6 integrert til et enkelt program. I 
denne Quick Reference kan du detaljert se hvilke kommandoner og verktøy som finnes 
tilgjengelige i Embroidery Canvas og i Hoop Canvas. Alle muligheter finnes ikke på alle 
produktnivåer. Du kan lese mer i Product Feature List i Reference Manual. 
 

Embroidery Canvas verktøysfelt 
 
I Embroidery Canvas  arbeidsfelt finner du nedenstående beskrevne verktøysfelt. Alle 
verktøyene inngår dog ikke i alle produktnivåer. 
 

Canvas arbeidsfelt 
Det finnes tre ulike arbetsfelt i BERNINA Broderi Software som nås via Canvas verktøysfelt. 

 
Importer, rediger eller lage vector artwork/bilder som utgangsbilde 
for et broderi til å stingsette manuelt eller automatisk. 
   
Stingsett og redigere broderidesigns. Viser både broderi og artwork. 
Se på et design realistisk i 3D simulering. 
 
Se på og rediger  multi-hoopings/flere rammeoppspenninger. Om 
broderiet er for stort eller inneholder flere designs som er utspredd, 
så deles motivet opp i flere rammeoppspenninger. 
 
Vis eller skjul hvert broderi-komponent.  
 
Konvertere Broderi til Artwork: konverterer valgte/markerte 
broderiobjekter til vector artwork. 
 
Konvertere Artwork til Broderi: konverterer valgte/markerte vector- 
eller bitmap-artwork til fyll- eller kontursting. 

   

 
Noter For en komplett beskrivelse av CorelDRAW® Essentials X6 verktøyet, les mer i den 
elektroniske User Guide som finnes tilgjengelig via Windows Start > Programs-gruppen. 
Alternativt, bruk onscreen help tilgjengelig via Graphics  > Help menyen. 
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Vanlig verktøysfelt 
Dette verktøysfeltet inkluderer verktøy til å åpne og stenge designs, adgang til ’design 
properties’/design-instillinger, og åpne og stenge ulike arbeidsvinduer. 
 

Åpne ny tomt design. 

 
Åpne et ferdig design. 

 
Lagre aktivt design. 

 
Print/skriv ut aktivt design med aktuelle instillinger. 

 
Se på design-arbeidsblad. Skriv ut et arbeidsblad fra dette vinduet. 

 
Send (lagre over) design til BERNINA design card, USB eller BERNINA 
broderimaskin. 
 
Samme som Edit > Cut / klipp ut. 

 
Samme som Edit > Copy / kopier. 

 
Samme som Edit > Paste /lim inn. 

 
Samme som Edit > Undo / angre. 

 
Samme som Edit > Redo / gjør igjen. 

 
Samme som File > Insert Embroidery / sett inn broderi. 

 
Samme som File > Insert Artwork /sett inn artwork/bilde. 

 
Adgang till underordnede programmer – Portfolio, Cross Stitch og 
Quilter 
 
Adganga til instillninger av valgte/markerede broderiobjekter eller til 
forhåndsinnstilligner, om intet er valgt/markert. 
 
Applisere stingeffekter på valgte broderi-objekt eller til 
forhåndsinnstillinger om intet er valgt/markert. 
 
Adgang til arbeidsfeltets innstillinger som gjelder rutenett, rammer, 
og rulliste-innstillinger. 
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Endre målenheter i Software-programmet uten å endre aktive 
systeminstillinger. 

 
 
Vis eller skjul Oversikts-vinduet. Bruk for å zoome og for å se miniatyr 
av aktuelt design.  
 
Vis eller skjul Color Film-vinduet. Bruk for å endre rekkefølge på 
objekt eller fargeblokk i designet. 
 
Vis eller skjul Carving Stamp-vinduet. Bruk grunninstillinger eller 
tilpass mønster for å lage et mønster av nålstikk. 
 
Vis eller skjul Morphing Effect-vinduet. Lag forendrede objekter i 
konturer og fyllsting. 
 
Vis eller skjul StumpWork Border-vinduet. Brukes i sammenheng med 
StumpWork verktøysboksen.  
 
 

View /Se Verktøysfeltet 
Dette verktøysfeltet inneholder verktøy for visualisering av designet. Les mer i Viewing Designs 
i Reference Manual. 

 
Vis eller skjul simulasjon av sydde sting (virkelig broderi). 

 
’Dimme’ bakgrunnsbilde for å vise stingene mer tydelig ved 
stingsetting. 
 

Vis eller skjul broderisting. 

 
Vis eller skjul nålstikket i broderiet. 

 
Vis eller skjul forbindelsesting mellom broderte objekter. 

 
Vis eller skjul alle bitmap/artwork som finnes i designet. 
 
Vis eller skjul all vektor/artwork som finnes i designet f.eks 
CorelDRAW® clipart. 
 

Vis eller skjul alle stumpwork under-designs som finnes i designet. 

 
Vis eller skjul  bakgrunnsting/farge på  alle applisserte objekter i 
designet. 
 
Vis eller skjul rammen. Høyreklikk for innstillinger. 

 
Vis eller skjul arbeidsoverflatens rutenett. Høyreklikk for innstillinger. 
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Vis eller skjul arbeidsoverfaltens linjaler og guider. Høyreklikk for 
innstillinger. 
Simuler hvordan broderiet sys ut på bildeskjermen, enten som en 
’tegnet’ eller ’virkelig’ film. 
 

Fargepalett 
Dette verktøysfeltet inneholder en palett av trådfarger samt ulike verktøy tilå velge/markere, 
applissere, og til å gå mellom fargene. Les mer i Thread Colors & Charts i Reference Manual. 

 
Plukk opp en farge fra et eksisterende objekt og bruk videre. 
 
Legg på den nåværende utvalgte fargen på broderiobjektet. 
 
 

Vis den nåværende valgte fargen  
 
Gå igjennom kombinasjoner av brukte farger. Høyre- eller 
venstreklikk. 
 
Adgang  til Color Wheel for å teste kombinasjoner av nærliggende 
farger. 
 

Søk etter matchende tråder fra ulike fabrikater, og velg for å bruke. 
 

Sting-verktøysfelt  
Dette verktøygsfeltet inneholder et antall ulike basekonturer og fyllsting, men også de med mer 
dekorativt utseende. Det inneholder også visse stingeffekter som kan applisseres. Venstreklikk 
på ikonet for å velge stingtype. Høyreklikk for å komme til dens innstillinger. Les mer i Outline & 
Fill Stitches i Reference Manual. 
 
Outlines/Konturer 
 

Lag en enkel rad med sting med en kontur – brukes fr kanter eller 
detaljer. 
 

Lag en bredere kontur ved at stingend syes tre gangergr – brukes for 
kraftigere kanter eller detaljer. 
 

Lag tradisjonelle atterstings-sømmer – en gammel tilpassende 
stingtype som brukes for delikate kanter. 
 

Lag tradisjonelle stilkestings-sømmer for detaljer som stilker og 
ranker. 
 
Lag en enda bredere kantsøm med valgfri bredde. 
 
Lag en opphøyd satin-kantsøm – kan brukes med trapunto for quilte-
effekter. 
 
Lag  langettsting som fine kantsømmer. 
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Lag ornamentelle kantsømmer/’håndbroderi’. Navnet Blackwork 
stammer fra tradisjonelt svart silketråds-broderi. 
 

Lag ornamentelle kantsømmer/’håndbroderi’. Du kan velge eksakt 
mønsterstørrelse og avstand. 
 

Lag ornamentelle kantsømmer/’håndbroderi’. Velg fra et 
mønsterbibliotek. 

 
Fills/Fyllsting 
 

Lag fyllsting for større, uregelmessige former. 

 
Lag fyllsting for mindre flater. 
 
Lag opphøyede flater – kan applisseres på bokstaver eller brukes med 
trapunto for quilteffekter. 
 

Lag fantasifulle fyllsting som fastholder stingfastheten. 

 
Lag 3D mønstereffekter med vridde/sirkulære fyllsting. 

 
Lag spiralmønster fra sentrum på et valgt fylt objekt. 
 
Lager broderi som følger objektets konturer, resultatet blir en lys-og-
mørk skyggeffekt. 
 

Lag fyllsømmer for blackwork designs. Navnet stammar fra 
tradisjonelt svart silketråds-broderi. 
 

Lag franske knuter – tradisjonelt hvitt-på-hvitt broderi oftest sydd 
med bomullstråd på hvit lin. 
 

Lag en blonde look med åpne ”spaljé”-liknende mønster. 
 

Lag dekorative fyllsting. Velg fra et mønsterbibliotek. 

 
Lag åpne mønsterfyllinger med korssting som passer standard-
rutenettet for hele designet. 
 

Lag fylling med bølgende sting som fyller hele overflaten innenfor 
kantene. 
 

Lag kraftigere slingrende sting med stilkestings-konturer. 
 

Lag kraftigere slingrende sting med atterstings-konturer. 
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 Effekter 
 
Forsterk og stabiliser objekt med underliggende sting. 
 
Lag ujevne kanter og skyggeeffekter, eller imiter ujevne teksturer. 

 
Lag  sirkulære mønster med visse stingtyper. Stingene legges fra 
ytterkant inn mot et geometrisk sentrumspunkt. Sentrumspunktet kan  
flyttes. 
 

Lag bølgeformede sting med en digitized guidelinje – stingene 
beholder samme tetthet. 

 
Transform / Endra verktøysfeltet 
Dette verktøysfeltet inneholder alle de verktøyene du behøver for å velge/markere, omforme, 
endre størrelse, og speglvende ditt broderiobjekt i Embroidery Canvas. Les mer i Arranging & 
Transforming Objects i Reference Manual. 
 

Klikk for å velge/marker et objekt eller dra en markeringsrute rundt 
ønsket objekt. 
 

Velg en uregelmessig flate eller form – klikk referansepunkter rundt  
objektet. 
 

 Endre form på detmarkerte broderiobjektet eller tekstobjektet. 
 
 
 
 
Øke/minske størrelsen på det markerte objektet i 20%-steg.            
Stingantallet blir automatisk omregnet. 

 
   
 

Speilvend markert objekt horisontalt eller vertikalt. 
 
 
 
 
 
Roter markert objekt i 45°-steg motsols eller medsols. 
 
 
 
Roter markert objekt til eksakt gradtall, positivt eller negativt. 

 
Forskyv markert objekt til eksakt gradtall, positivt eller negativt. 
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Endre innstillinger for eksakt plassering av markerte objekter. Brukes 
sammen med Rulers & Guides. 
 

Endre størrelse på objekt eller hele designet  
ved å skrive inn eksakt bredde eller hyded, eller  
et procenttall. Bruk Aspect Ratio-låsen for å 
beholde proporsjonene. 

 
Zoom verktøysfeltet 
Dette verktøysfeltet inneholder alle de verktøyene du behøver for å zoome og panorere. Det 
finnes også andre zoom grunninstillinger tilgjengelige via View-menyen. Les mer i Zooming & 
panning i Reference Manual. 
 

Venstreklikk for å zoome inn, høyreklikk for å zoome ut, eller dra 
en ’zoom-box’. Kortkommando <B> kan også brukes. 
 
 
 
Zoom Factor: vegl noen av de ferdigutfylte zoom-verdien frå drop-listen  
eller skriv selv inn ønsket verdi og trykk Enter. 
 
 
 
 
 
Dra for å panorere over designet med høy zoom-faktor. 
Kortkommando <P> kan også brukes. 

 
 

Embroidery Canvas verktøy 
 
I Embroidery Canvas arbeidsflate finner du et verktøysvindu med følgende  beskrevne verktøy 
permanent synlige til venstre. Verktøysvinduet inneholder et antall rulle-lister som  inneholder 
verktøysgrupper inndelt som følger. 
 
Edit/Redigere verktøyssett 
Dette settet inneholder alle verktøy du behøver for å redigere broderi-designs i Embroidery 
Canvas mode 
 

Klipp hull i fylte objekter. 
 

Ta bort hull fra markerte objekter 
 
 

Legg til stingvinkel i lukkede objekter med eller uten hull. Høyreklikk for  
innstillinger. 

 

Ta bort stingvinkel fra lukkede objekter med vridde sting. 
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Forsrerk konturer, ved å også sy i motsatt retning. 
 
Automatisk sekvensvalgte konturer for effektiv utbrodering. 
 
Lag broderate fargeoverganger i valgte objekt. 
 
 

Fyll hull i markerte objekt med forhåndsvalgte stingtyper. 
 

Automatisk kontur legges på markerte objekt med singel-, trippel- eller  
Satinsøm. 
 

Brukes i forbindelse med opphøyd satin for å lage et opphøyd  
”quiltet” utseende. 
 

Deler opp monogram, applikasjoner, tekst, og blackwork sømmer i  
mindre komponenter slik at respektive objekt kan redigeres. 
 

Ta bort uønskede sting som ligger under objekt eller tekst. 
 
Ta bort uønskede sting som ligger under applikasjons-objektet. 
 
 
Plasser sting-markøren ved et valgt utgangspunkt. 
 
 

Auto Digitize/automatisk stingsettnings-verktøy 
Disse verktøyene brukes for automatisk stingsettning av artwork i Embroidery Canvas mode. 
Les mer om Automatic Digitizing i Reference Manual. 

 
Automatisk stingsettning av ferdig bitmap artwork/bilde. 
 
Automatisk stingsettning av fylte flater i et vector eller bitmap  
artwork/bilde. 
 

Konvertere et fotografi (svart-hvitt eller farg) til broderi. 
 

 
Digitize / stingsettningsverktøy 
Disse verktøy brukes for manuell stingsettning i Embroidery Canvas mode. Høyreklikk for å 
komme til innstillinger. Les mer om Digitizing Methods i Reference Manual. 
 

Stingsett et ’åpent’ broderiobjekt. 
 
Stingsett et ’stengt’ broderiobjekt. 
 
Tegn på frihånd en broderat kontur (’åpen’) direkte på bildskjermen 
med valgt stingtype. 
 

Tegn på frihånd et brodert broderi-objekt (’stengt’) på bildeskjermen  
med valgt stingtype – kontur eller fyllsting. 
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 Stingsett kolumner med vridde sting. 

 
Stingsett elipser eller sirkler til broderte objekter. 
 
Stingsett rektangler eller kvadrater til broderte objekter. Trykk <Ctrl> 
for å lage et eksakt kvadrat. 
 

Lag brodert tekst direkte på bildeskjermen. 
 
Lag personlige monogram ved å bruke et utvalg av ferdige 
typesnitt, border, rammer og ornamenter. 
 
Konverter/digitaliser  stengte objekter til applikasjoner med alle  
sømmene. 
 

Konverter åpne objekter til applikasjoner fra en eller flere andre  
objekter. 
 
Stingsett et enkelt knapphåull med alle nødvendige sting. 

 
Stingsett en rad med knapphull med alle nødvendige sting. 
 
Digitaliser PunchWork designs som brukes sammen med  
BERNINA Punch Tool for roterende gripere. 
 

Plasser individuelle/ferdige mønster i designet, velg fra et mønster-  
bibliotek. 
 

Frihånds-innstillinger verktøysfelt 
Når Frihånds-verktøyet er aktivert, så vises dette verktøysfeltet. 

 
Bruk ’Show Guide’ for å forenkle frihånds-digitizing  - den gir mer 
kontroll over frihånds-tegningen enn standardpekaren. 
 
Bruk’Guide Inner Circle Radius control’ for å stille inn størrelsen på  
den indree sirkelen ved bruk av frihånds-digitizing guiden. 
 
Bruk’Number of Guide Circles control’ for å stille inn antall sirkler 
for frihåndspekeren – hvis den innerste sirkelens radius er 2 mm, får  
hver ytterligere guide cirkel et offset-verdi på 2 mm. 
 
Bruk’Smoothing control’ for å stille inn, i prosentverdi, hvor nær 
den myke konturen stemmer med originalen. 
 
 

StumpWork verktøy 
StumpWork verktøyet nås via  verktøysfeltet. Det inneholder alle de verktøy som behøves for å 
digitalisere stumpwork fra begynnelsen eller å lage stumpwork fra et eksisterende objekt. Les 
mer om Stumpwork embroidery i Reference Manual. 
   



BERNINA® Embroidery Software 7      
Quick Start Guide 

 

23 
 

Lag stumpwork-kanter fra valgte objekt. 

 
Digitaliser en åpen stumpwork-kant ved å bruke en stingsatt  
kontur med nåværende innstillinger. 

 
Digitalisera en stengt stumpwork-kant ved å bruke en stingsatt  
kontur med nåværende innstillinger. 

  
  Klipp/åpne en stengt stumpwork-kant for å  få en åpning – til  
  ståltrådsendene. 

 
Lag en ståltrådslinje ved å bruke en stingsatt  
kontur med nåværende innstillinger. 

 
  Lag stumpwork under-design fra valgt/markert objekt som  
  inkluderer broderi inni en stumpwork-kant. 

 
  Se på og rediger valgte stumpwork under-designer. 

 
  Lagre stumpwork under-design som en separat design fil. 
  
      
 
     
Mirror-Merge verktøy 
Disse verktøyene brukes for å kopiere og gjøre om valgte broderiobjekt i vertikale og 
horisontelle plan. Les mer om Mirroring objects i Reference Manual. 

 
Dupliser og speilvend horisontalt og sammenføy overlappende  
objekter (valgfritt). 
 

Dupliser og speilvend vertikalt og sammenføy overlappende  
objekter (valgfritt). 
 
Dupliser og speilvend objektene rundt et sentrumspunkt. 
 
 
Dupliser valgte objekter rundt en sentrumsaksel. Endre innstillinger i   
Mirror-Merge innstillings- og verktøysfelt.. 
 

Dupliser og speilvend objekt rundt en centrumsaksel. Endre 
innstillingar i Mirror-Merge innstillings- og verktøysfelt. Dette verktøyet  
blir synlig når ’Wreath Tool’ er aktivert. 
 

Skriv inn ønsket antall wreath punkter. Skriv inn jevne nummer for å  
aktivere kaleidoskopet. 
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Arrangere verktøy 
Disse verktøy brukes for å eksakt plassere objekter med ulike linjer, fordele og speilvende 
objekter i Embroidery Canvas. Les mer om Arranging & Transforming Objects i Reference 
Manual. 
      

Kombiner flere objekter  til et valgbart objekt ved å grupper. 
 
Del opp et sammensatt objekt inntil flere komponenter ved å ugruppere 

. 
 
Lås valgte objekter for beskyttelse. 
 
Lås opp valgte objekter for å ta bort beskyttelsen. 
 
Flytt valgte objekter til venstre. 
 
 
Flytt objekter vertikalt. 
 
Flytt valgte objekter til høyre. 

 
Flytt valgte objekter til toppen. 

 
Flytt valgte objekter horisontalt. 

 
Flytt valgte objekter til bunnen. 

 
Sentrer horisontalt og vertikalt. 

 
Fordel tre eller flere valgte objekter horisontalt. 
 
Fordel tre eller flere valgte objekter vetikalt    
 
 

Color Film verktøysfelt 
Dette verktøysfeltet finnes i Embroidery Canvas. 
 

Se de individuelle objekter i forhold til syrekkefølgen. ’Drag 
and drop’ objekt for å endre på syrekkefølgen.. 
 
Flytt valgt objekt bak/frem stegvis i sømsekvensen 
 
 
 
 
Flytt valgt objekt bak / frem en farge i sømsekvensen. 
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Flytt valgt objekt til start / sluttpunkt i sømsekvensen. 
 
 

 
Endre rekkefølgen på objektet. 

 
Endre rekkefølgen av blokk med samme farger. (For å beholde  
separate fargeblokker, bruk Color Film.) 
 
 

Multi-Hooping toolbar 
 
Dette verktøysfeltet finner du i Hoop Canvas. Les mer under Hooping Design i Reference 
Manual for detaljer. 

 
Tilføy en ny ramme til multi-hooping layoutet. 
 
Plasser en ny ramme til høyre for den valgte rammen. Den tillater 10 
mm overlapp mellom rammene. 
 

Plasser en ny ramme ovenfor den valgte ramme. 

 
 
Få 4/8 rammer rundt omkring den valgte rammen. Den tillater 10 mm 
Overlapp mellom rammene.  
 

 
Digitaliser en eller fler guider/markeringer i et multi-hoop layout for  
å dele opp objektet mellom rammene. 
 

Fjern den valgte rammen fra layoutet. 
 
Beregn/planlegg rammer utfra det nåværende layout. 
 

 
 
   
 
 
 

 
 

 
 
   
   
   


